
INSTALLATION GUIDE

SCXI -1314T TEDS Bridge Sensor 
Terminal Block

This guide describes how to install and use the SCXI-1314T terminal block 
with the SCXI-1520 module and hardware Transducer Electronic Data 
Sheet (TEDS)-enabled bridge sensors (IEEE-P1451.4 Class 2).

The SCXI-1314T terminal block works with the SCXI-1520 universal 
strain/bridge sensor module to conveniently connect hardware TEDS smart 
sensors using RJ-50 10 position/10 conductor (10p10c) modular plugs. 
There are 10 pins arranged in eight modular jacks. Each jack corresponds 
to one of the eight channels available on the SCXI-1520. For a complete 
description of the use and operation of the SCXI-1520 module, refer to the 
SCXI-1520 User Manual.

Conventions
The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

When this icon is marked on the product, refer to the Read Me First: Safety 
and Radio-Frequency Interference document, shipped with the product, for 
precautions to take.

When symbol is marked on a product, it denotes a warning advising you to 
take precautions to avoid electrical shock.

When symbol is marked on a product, it denotes a component that may be 
hot. Touching this component may result in bodily injury.

™
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bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

What You Need to Get Started
To install and use the SCXI-1314T terminal block, you need the 
following items:

❑ Hardware

– SCXI-1314T terminal block

– SCXI-1520 module

– SCXI or PXI/SCXI combination chassis

– Cabling, cable adapter, and Wheatstone-bridge sensors as 
required for your application

❑ Documentation

– Read Me First: Safety and Radio-Frequency Interference

– SCXI Quick Start Guide

– SCXI-1314T TEDS Bridge Sensor Terminal Block 
Installation Guide

– SCXI-1520 User Manual

– SCXI or PXI/SCXI combination chassis user manual 
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❑ Tools

– Number 2 Phillips screwdriver

– Long-nose pliers

– Wire cutter

– RJ-50 terminal crimper

❑ Cables and plugs

– Shielded twisted pair (up to 5 pair, 10 conductor) cable

– Up to eight RJ-50 (10p10c) modular plugs

Note If your application does not require shunt calibration, you also can use RJ-45 
10 position/8 conductor (10p8c) modular plugs in which only pins 2 through 9 are 
populated. However, NI recommends using the RJ-50 (10p10c) for most applications.

Changing the Shunt Resistors

Note Refer to the Read Me First: Safety and Radio-Frequency Interference document 
before removing equipment covers or connecting or disconnecting any signal wires.

Each channel input contains pins that connect to the inputs and outputs of 
the SCXI-1520, and to a precision 100 kΩ shunt calibration resistor. The 
SCXI-1520 contains relays that switch the resistors in and out of the input 
circuit to provide shunt calibration. These resistors are placed in sockets 
on the SCXI-1314T terminal block so you can easily replace them with 
resistors suitable to the specific Wheatstone-bridge sensor in your 
application. If your application requires different shunt resistor values, 
exchange the resistors with the appropriate value 1/4 W resistors.

Note Only the shunt resistors are socketed.
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To change shunt resistors, complete the following steps, referring to 
Figures 1 and 2 as necessary:

1. Unscrew the top cover screws and remove the top cover.

Figure 1.  SCXI-1314T Parts Locator Diagram

2. Use long-nose pliers to carefully remove the socketed 100 kΩ 
precision resistors.

Note To avoid damaging the precision resistors, pull the leads directly, alternating the 
force back and forth rather than pulling the resistor itself.

3. Use wire cutters to shorten the new resistor leads to 6.4 mm (0.25 in.).

1 Top Cover Screws
2 Top Cover

3 RJ-50 Connector
4 Thumbscrew

1

2

3

4
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4. Use long-nose pliers to insert the new resistors into the sockets, 
indicated in Figure 2.

Figure 2.  SCXI-1314T Shunt Resistor Sockets

5. Reinstall the top cover and tighten the top cover screws.

6. Refer to the SCXI Quick Start Guide to finish installing the 
SCXI-1314T and configure it in Measurement & Automation Explorer 
(MAX), and to find instructions for taking measurements.

1 Shunt Resistor Sockets

1
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Channel Signals
Table 1 lists the signal names of the terminals for each channel, and lists 
the correlation between the pin numbers of the RJ-50 (10p10c) modular 
plug and the SCXI-1314T receptacle.

 

TEDS Sensor Bridge Configurations
This section describes the quarter-, half-, and full-bridge TEDS sensor 
bridge configurations available for use with the SCXI-1314T.

Table 1.  Channel Signal Names

RJ-50 (10p10c) Modular Plug 
and SCXI-1314T Receptacle 

Pin Numbers Pin Signal Name Signal Description

1 SCA Shunt calibration

2 AI + Positive input signal 

3 AI – Negative input signal 

4 RS + Positive remote sense signal

5 RS – Negative remote sense signal

6 EX + Positive excitation signal

7 EX – Negative excitation signal

8 T + TEDS data

9 T – TEDS ground

10 SCA Shunt calibration

CH0

CH1

Pin 1

Pin 10

Pin 1

Pin 10
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Quarter-Bridge
This section shows the quarter-bridge signal connections. Figure 3 shows 
the quarter-bridge circuit wiring diagram.

Note AI – is left unwired. Set the SCXI-1520 module to internal half-bridge completion. 
Refer to the SCXI-1520 User Manual for more information.

Figure 3.  Quarter-Bridge Circuit Diagram

The following symbols apply to the circuit diagram and equations:

• R1 and R2 are half-bridge completion resistors.

• R3 is the quarter-bridge completion resistor (dummy resistor) you 
provide externally to the SCXI-1314T.

• R4 is the active measuring element.
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• VEX is the excitation voltage.

• RL is the lead resistance.

• VAI is the measured voltage.

• VRS is the remote sense measured excitation voltage.

• T + is the TEDS data transmission line.

• T – is the TEDS ground reference.

Note For greatest calibration accuracy, use separate wires between the bridge and the 
SCA terminals as shown in Figure 3.
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Half-Bridge
This section shows the half-bridge signal connections. Figure 4 shows the 
half-bridge circuit wiring diagram.

Note AI – is left unwired. Set the SCXI-1520 module to internal half-bridge completion. 
Refer to the SCXI-1520 User Manual for more information.

Figure 4.  Half-Bridge Circuit Diagram

The following symbols apply to the circuit diagram and equations:

• R1 and R2 are half-bridge completion resistors.

• R3 and R4 are the active measuring elements.

• VEX is the excitation voltage.
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• RL is the lead resistance.

• VAI is the measured voltage.

• VRS is the remote sense measured excitation voltage.

• T + is the TEDS data transmission line.

• T – is the TEDS ground reference.

Note For greatest calibration accuracy, use separate wires between the bridge and the 
SCA terminals as shown in Figure 4.
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Full-Bridge
This section shows the full-bridge signal connections. Figure 5 shows the 
full-bridge circuit wiring diagram.

Figure 5.  Full-Bridge Circuit Diagram

The following symbols apply to the circuit diagram and equations:

• R1, R2, R3, and R4 are active measuring elements.

• VEX is the excitation voltage.

• RL is the lead resistance.

• VAI is the measured voltage.

• VRS is the remote sense measured excitation voltage.

• T + is the TEDS data transmission line.

• T – is the TEDS ground reference.
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Note For greatest calibration accuracy, use separate wires between the bridge and the 
SCA terminals as shown in Figure 5.

Connecting the Signals
Complete the following steps to connect the signals wires to the 
RJ-50 (10p10c) modular plug:

1. Determine the number of signals used in your application. You can use 
a maximum of 10 signal wires per RJ-50 (10p10c) modular plug.

2. Choose the shielded twisted pair (up to 5 pair, 10 conductor) cable for 
your application. The recommended twisted pairs are as follows:

• (AI +/AI –)

• (RS +/RS –)

• (EX +/EX –)

• (T +/T –)

• (SCA/SCA)

3. Expose 12.7 to 15.9 mm (0.500 to 0.625 in.) of signal wires without 
stripping the insulation as shown in Figure 6. Do not strip the 
insulation from the exposed signal wires.

Figure 6.  Unstripped Exposed Wire for RJ-50 (10p10c) Modular Plug Connection

4. Determine the color coding of the signal wires for your application.

5. Untwist and flatten the wires into the correct color order for your 
application. Maintain the twist in the wire as close as possible to the 
RJ-50 modular plug while allowing enough room to insert the wires 
into the plug.

1 Insulation 2 Shielding 3 Unstripped Signal Wires

1 2 3
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6. Insert the wires into the RJ-50 (10p10c) modular plug as shown in 
Figure 7.

Figure 7.  Inserting Signal Wires into RJ-50 (10p10c) Modular Plug

7. Crimp the terminal using an RJ-50 terminal crimper as shown in 
Figure 8.

Figure 8.  Crimping the RJ-50 (10p10c) Modular Plug

1 Insulation
2 Shielding

3 Unstripped Signal Wires
4 RJ-50 (10p10c) Modular Plug

1 Shielded Twisted Wire Cable
2 RJ-50 (10p10c) Modular Plug

3 RJ-50 Terminal Crimper

1 2 3 4

3
2

1
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Note Refer to ni.com/info and enter info code rdrj50 for more information on 
RJ-50 modular plug crimpers, modular plugs, and cables.

8. Use only one of the following methods to ground the signals wires in 
your TEDS application:

• Attach the cable shielding to the TEDS sensor as shown in 
Figure 9.

Figure 9.  Attach the Shielding to the TEDS Sensor

• Connect the cable shielding to the metal grounding portion of the 
RJ-50 (10p10c) modular plug with a grounding wire as shown in 
Figure 10.

Figure 10.  Connect the Shielding to the RJ-50 (10p10c) Modular Plug

1 Cable Shielding 2 Cable Insulation 3 TEDS Sensor

1 Ground Shield
2 Grounding Wire

3 Cable Insulation
4 Cable Shielding

3

1
2

4

21 3



© National Instruments Corporation 15 SCXI-1314T TEDS Bridge Sensor Terminal Block

• Connect the conduit cable shielding to the metal thumbscrew of 
the SCXI module with a grounding wire as shown in Figure 11.

Figure 11.  Connect the Shielding to the SCXI Module Using the Thumbscrew

9. After you have grounded your application, insert the RJ-50 (10p10c) 
modular plugs into the SCXI-1314T.

Note Improperly grounding the shielding causes signal noise.

10. Refer to the SCXI Quick Start Guide to power on the SCXI chassis and 
configure the system in software.

1 Conduit Cable Insulation
2 Grounding Strap Wire
3 SCXI Module
4 Thumbscrew

5 SCXI-1314T
6 RJ-50 (10p10c) Modular Plug
7 Twisted Pair Cable
8 Cable Shielding

NI SCXI-1314T

CH0

CH1

CH2

CH3

CH4

CH5

CH6

CH7

1

2

3

4

5

67

8
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TEDS-Related Information
You can find more TEDS-related information in the following locations:

• Measurement & Automation Explorer Help for NI-DAQmx and the 
NI-DAQmx Help

• ni.com/info, entering any of the following info codes:

– rdsenr

– rdpnpy

– rdpnsn

– rdted6

– rdrscl

Specifications
All specifications are typical at 25 °C unless otherwise specified.

Electrical
Shunt calibration resistors ......................RN-55 style 1/4 W

Accuracy of resistors

100 kΩ shunt calibration resistor ....±0.1%

Temperature coefficient of resistors

100 kΩ shunt calibration resistor ....±10 ppm/°C

Mechanical
Resistor sockets

Lead size..........................................0.6 to 0.7 mm
(0.023 to 0.026 in.)

Lead length ......................................2.8 to 4.4 mm
(0.110 to 0.175 in.)

Lead spacing....................................12.7 mm
(0.500 in.)

RJ-50 receptacle

mean number of insertions
before failure ...................................500
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Maximum Working Voltage
Maximum working voltage refers to the signal voltage plus the 
common-mode voltage.

Analog signals

Channel-to-earth ............................. Either the AI X + or AI X – input 
should remain within ±10 V of 
ground. Both inputs should be 
within ±10 V of one another, 
Installation Category I.

Channel-to-channel ......................... Either the AI X + or AI X – input 
should remain within ±10 V of 
ground. Both inputs should be 
within ±10 V of one another, 
Installation Category I.

Digital signals

Channel-to-earth ............................. 0 to 5 V of one another

Environmental
Operating temperature............................ 0 to 50 °C

Storage temperature ............................... –20 to 70 °C 

Humidity ................................................ 10 to 90% RH, noncondensing

Maximum altitude .................................. 2,000 m

Pollution Degree (indoor use only) ........ 2

Safety
The SCXI-1314T terminal block meets the requirements of the following 
standards for safety and electrical equipment for measurement, control, and 
laboratory use:

• IEC 61010-1, EN 61010-1

• UL 61010-1

• CAN/CSA C22.2 No. 61010-1

Note For UL and other safety certifications, refer to the product label, or visit 
ni.com/certification, search by model number or product line, and click the 
appropriate link in the Certification column.
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Electromagnetic Compatibility
Emissions................................................EN 55011 Class A at 10 m

FCC Part 15A above 1 GHz

Immunity ................................................EN 61326:1997 + A2:2001, 
Table 1

EMC/EMI ...............................................CE, C-Tick, and FCC Part 15 
(Class A) Compliant

Note For EMC compliance, operate this device with shielded cabling.

CE Compliance
The SCXI-1317 terminal block meets the essential requirements of 
applicable European Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety)..............73/23/EEC

Electromagnetic Compatibility
Directive (EMC) .....................................89/336/EEC

Note Refer to the Declaration of Conformity (DoC) for this product for any additional 
regulatory compliance information. To obtain the DoC for this product, visit 
ni.com/certification, search by model number or product line, and click the 
appropriate link in the Certification column.



National Instruments™, NI™, ni.com™, NI-DAQ™, and SCXI™ are trademarks of National Instruments 
Corporation. Product and company names mentioned herein are trademarks or trade names of their 
respective companies. For patents covering National Instruments products, refer to the appropriate 
location: Help»Patents in your software, the patents.txt file on your CD, or ni.com/patents.

© 2004 National Instruments Corp. All rights reserved.
373746C-01 Aug04
*373746C-01*


	SCXI-1314T TEDS Bridge Sensor Terminal Block Installation Guide
	Conventions
	What You Need to Get Started
	Changing the Shunt Resistors
	Figure 1. SCXI-1314T Parts Locator Diagram
	Figure 2. SCXI-1314T Shunt Resistor Sockets

	Channel Signals
	Table 1. Channel Signal Names
	TEDS Sensor Bridge Configurations
	Quarter-Bridge
	Figure 3. Quarter-Bridge Circuit Diagram
	Half-Bridge
	Figure 4. Half-Bridge Circuit Diagram
	Full-Bridge
	Figure 5. Full-Bridge Circuit Diagram

	Connecting the Signals
	Figure 6. Unstripped Exposed Wire for RJ-50 (10p10c) Modular Plug Connection
	Figure 7. Inserting Signal Wires into RJ-50 (10p10c) Modular Plug
	Figure 8. Crimping the RJ-50 (10p10c) Modular Plug
	Figure 9. Attach the Shielding to the TEDS Sensor
	Figure 10. Connect the Shielding to the RJ-50 (10p10c) Modular Plug
	Figure 11. Connect the Shielding to the SCXI Module Using the Thumbscrew


	TEDS-Related Information
	Specifications
	Electrical
	Mechanical
	Maximum Working Voltage
	Environmental
	Safety
	Electromagnetic Compatibility
	CE Compliance




